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7.  CALCULATING RESULTS

7.1.  Overview of THERM Calculation Methods
THERM is a two-dimensional (2D) finite-element heat-transfer analysis tool. Many excellent reference books
describe the finite element method in detail(8,9). THERM’s steady-state conduction algorithm, CONRAD(10), is a
derivative of the public-domain computer program TOPAZ2D(6,7). THERM’s radiation view-factor algorithm,
VIEWER, is a derivative of the public-domain computer program FACET(12). THERM contains an automatic
mesh generator that uses the Finite Quadtree(5) algorithm. THERM checks solutions for convergence and
automatically adapts the mesh as required using an error-estimation algorithm based on the work of
Zienkiewicz and Zhu(18,19).

THERM’s calculation routines evaluate conduction and radiation from first principles. Convective heat
transfer is approximated through the use of film coefficients obtained from engineering references(11,17).

See Appendix C, "Theoretical Background" for more information about the calculation methods in THERM.

7.2.  Calculations
When you have finished drawing a cross section, specifying its materials, and defining boundary conditions,
you are ready to calculate the cross section’s thermal performance.

7.2.1.  Calculation Menu

The Calculation menu choices are shown in the figure below. If the results are not current, the Display
Options and Stop Current Calculation menu choices will be inactive (grayed out) until you calculate current
results.

Figure 7-1.  The Calculation menu choices

Calculation (F9) Use this menu choice or the F9 keyboard short cut to start the calculation for a
currently active THERM file. This is equivalent to pressing the Calculation
toolbar button.

Display Options
(Shift-F9) Use this choice or the Shift-F9 keyboard short cut to access the Results Display Options

dialog box. The default setting is to display isotherms when a calculation is finished. The
results will display with the last choice selected. If the Display Options menu choice is
inactive (gray), the results are not current, so you need to calculate them before you can
access this choice.
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Figure 7-2.  The Results Display Options dialog box

Show U-factors
(Ctrl-F9) Use this choice or the Ctrl-F9 keyboard short cut to display the U-Factors results dialog

box. See Section 7.4.1, "U-factors" for more information about the U-Factors results
display.

Calc Manager Use this choice to run a list of THERM files in batch mode. The program runs the files
one at a time, starting from the file at the top of the list. Selecting the Calc Manager
menu choice opens the Calculation Manager dialog box, shown in the figure below:

Figure 7-3. Selecting the Calculation/Calc Manager menu choice opens the Calculation Manager dialog box
which shows a list of THERM files that can be run.

The Calculation Manager buttons are as follows:
� Close:  The Close button closes the Calculation Manager dialog box. Even if this box

is closed, the THERM files in the queue will still run.
� Add:  The Add button is used to add another THERM file to the end of the list of

files to run. Pressing Add opens a browse window which allows you to select files
from anywhere on your computer or network. You can select multiple files using
your mouse with either the Shift key (to select multiple contiguous files) or the Ctrl
key (to select multiple noncontiguous files), in standard Microsoft Windows™ style.

� Remove:  The Remove button deletes a file from the list. Highlight a file in the list by
clicking on it once with your mouse; then, press Remove. The file will be deleted
from the list.

� Start or Pause:  The Start or Pause button toggles between starting and pausing files.
If the button says Start, clicking on it causes the program to start running the files in
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the list, beginning with the first file. If the button says Pause, clicking on the button
causes the program to pause running all of the files in the list. You can click on the
button when it says Pause (which changes the button to say Start) and then you can
click the Add button to select additional files to be run. When you are ready for the
files to begin running, click on the Start button.

� Interrupt:  The Interrupt button causes the currently running THERM file to be
stopped after the program finishes the current calculation step (such as Reading
Geometry or Generating Input.)

� Log:  The Log button displays a list of the files that have been run as well as any
error messages generated during the calculation. This log can be cleared manually
using the Clear Log button on the Calculation Log dialog box, and it is
automatically cleared when you close the THERM program.

Figure 7-4.  Calculation Log accessed from Calc/Calc Manager.

Background Calc Selecting the Background Calc menu choice causes the program to run the simulation in
the background, allowing you to do other work in THERM while a model is being
calculated. When Background Calc is on, the program displays the file name and the
current calculation status (such as "Generating Input" or "Simulating") in the THERM
status bar (see Chapter 4 for the location of the status bar). If Background Calc is
selected, a check mark will display to the left of the menu choice, and the feature will
remain on until it is unchecked. If this option is not turned on, an hourglass will be
displayed while the program runs a THERM file, and you will not be able to do any
other work until the calculation is finished.

Add to queue Selecting the Add to queue menu choice causes the currently active THERM file to be
added to the Calc Manager list.

Stop Current
Calculation Selecting the Stop Current Calculation menu choice causes the currently active and

running THERM file to be cancelled. THERM will finish the current calculation step,
such as "Reading Geometry" or "Generating Input", before stopping.

7.2.2.  Calculating Results for a THERM file

To start calculating a THERM file, do the following:

1. Set the appropriate Options/Therm File Options and Options/Preferences, Simulation settings (see
7.2.3, "Calculation Options" for a description of these values).
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2. Turn on Background Calc from the Calculation menu. When it is on, a check mark will appear to the
left of the Calculation/Background Calc menu choice.

3. Press the Calculation toolbar button, use the Calculation/Calculation menu item, or press F9 to
start the calculation.

4. The program will show the calculation steps being performed (because Background Calc is turned
on). Depending on the complexity of the cross section and the fineness of the mesh as well as the CPU
speed and amount of memory of your computer, calculation steps can take several seconds to a few
minutes.

The status of the calculation is
displayed when Background
Calc is checked. The
calculation steps are:

� Premeshing
� Reading Geometry
� Meshing
� Generating Input
� Simulating

Click on Background Calc (a check
appears to the left of the menu choice
indicating that it is "on") so you can
work on other THERM files.

Figure 7-5.  THERM displays the steps in the calculation when the Calculation/Background Calc menu option is on.

7.2.3.  Calculation Options

There are several calculation options which may be changed. In most cases, the default values for these
options will be appropriate.

One category of calculation options is accessed from the Options/Therm File Options menu, which opens a
dialog box with the following settings:

Quad Tree Mesh
Parameter The mesh parameter determines the maximum element size in the mesh.  The larger the

mesh parameter, the smaller the maximum size.  When modeling cross sections with
very fine detail, you may need to increase this setting.  Increasing the mesh parameter
also increases the number of elements and, as a result, increases the time required to
generate the mesh. Lower numbers produce coarser mesh, higher numbers produce a
finer mesh. (Note: The mesh parameter is based on geometry, and if a fine detail in the cross
section is not being meshed to the level you think is necessary, and increasing the mesh parameter
doesn’t change this, you should check the Run Error Estimator check box and the mesh will be
refined in this region if it is necessary.) Default: 6.
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Run Error
Estimator The Run Error Estimator check box governs whether THERM runs its error estimator.

The purpose of the error estimator is to locate regions of potential error, so the mesh can
be refined there to increase the accuracy of the program’s calculation.  The error
estimator calculates a percent error energy norm.  The percent error energy norm is a
function of the heat flux integrated over the area of the element.  If the percent error
energy norm is high, the program refines the mesh so that the regions of high heat flux
are integrated over smaller elements.  This can be mathematically proven to result in a
converged solution(18,19). The default value for this percentage is 100%, which means
THERM will not refine any areas of the mesh even when the error estimator runs. You
can change the default value, but this is not necessary in all cases.  The value of the
percent error energy norm for your simulation will be displayed under
Calculation/Show U-factor.

The following approach is suggested if you want to use the error estimator to have
confidence that your solution is converged. First, simulate your cross section using the
default setting for the error estimator. Check the percent error energy norm results,
which appear under Show U-factors in the U-Factor dialog box, which is accessed by
the Calculation/Show U-factors command under the Calculation menu.  If the value is
less than 10%, you can assume that your solution is converged. If the percent error
energy norm is larger than 10%, check the values of the particular results (e.g., U-factor,
local temperatures, etc.) that are of interest to you.  Then rerun your problem by
entering a value for the percent error energy norm that is smaller than the one currently
reported in the U-factor dialog box.  (Entering a target value for the percent error energy
norm that is a factor of two smaller than the current reported value is reasonable way to
proceed, or you can set the value between 5 and 10 %.)  THERM will iterate until the
percent error energy norm of every element in the cross section is less than the target
value or until the specified maximum number of iterations is reached. Verify the change
in percent error energy norm and recheck the results of interest (e.g. U-factors, etc.) for
your cross section.  If the results of interest have changed significantly, you may wish to
rerun the calculation after decreasing the percent error energy norm until no significant
change in results is observed. This strategy will allow you to achieve the desired level of
accuracy required for your solution.

Note: The larger the mesh parameter and the smaller the percent error energy norm, the
more elements will be included in your mesh and the longer your calculation time will
be.  A fine initial mesh will have a lower maximum percent error energy norm than a
coarse mesh.  A fine mesh may reach a converged solution with one run whereas a
coarse mesh may take many iterations to reach the same level of convergence. You can
attempt to achieve a percent error energy norm of less than 5%, but this may result in
over-refinement of the mesh and accumulated round-off error, which will have an
adverse effect on the accuracy of the solution.

Default: checked.
Maximum % Error
Energy Norm If the Run Error Estimator box is checked, the Maximum % Error Energy Norm value

determines the percent error energy norm allowed. THERM will rerun the simulation
until this value is reached. See Run Error Estimator above regarding when to change
this value. Default: 100%

Maximum
Iterations This box specifies the maximum number of times the program will modify the mesh and

resimulate if the Run Error Estimator box is checked.  THERM will stop simulating and
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display a warning message when this value is exceeded even if the target value for the
percent error energy norm has not been reached. The last set of results will be displayed.
Default: 3.

Use CI Model for
Window4 Glazing
Systems A check box indicates that you want to use the Condensation Index Model when

WINDOW4 glazing systems are imported. Default:  unchecked

Figure 7-6.  THERM File Options affect how THERM calculates results.

Another category of calculation options is accessed from the Options/Preferences menu, Simulation tab,
which opens a dialog box with the following settings:

Convergence
Tolerance This feature is used when the detailed radiation model is chosen.  This is an iterative

model that calculates the nonlinear temperature relation that develops in combined
conduction and radiation simulations.  The convergence tolerance is the allowable
maximum average temperature difference between two successive iterations. Default:
0.0001

Relaxation
Parameter The relaxation parameter is also related to convergence in problems containing the

detailed radiation model.  A relaxation parameter of less than one may help a problem
to converge. Default: 1

View-Factor
Smoothing View-factor smoothing is the least square fit of view factors, which often provides

betters results for view factors. Default: checked

Save Simulation
Results in THM
Files This check box determines how the results are saved. You can save results with the

THERM file, which creates a large file containing all of the mesh, temperature, and U-
factor results for a cross section. If this box is not checked, the files are much smaller
(1K) and only contains the U-factor results; you will be able to view the geometry of the
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cross section, the U-factors, and the report but not the mesh or temperature results. In
this case, the results are current but not available and the Calc/Display Options menu
choice will be inactive (grayed out). Default: checked

Save CONRAD
Results file (.O) This option saves the CONRAD results files, that are named with the THERM file name

with an extension of .O. This is an ASCII file that contains all the information about the
model geometry, mesh, temperature and heat flux results. Default: unchecked

Save simulation
Intermediate files This option is useful in determining why a simulation has failed. Intermediate files are

saved in the SIM subdirectory of the THERM directory, and quickly use up disk space.
This is primarily a research feature. Default: unchecked

Figure 7-7.  The Simulation preferences accessed from the Options/Preferences menu

7.3.  Feedback and Troubleshooting During the Calculation Process

During the calculation process, the feedback bar will identify which stage of the automated calculation
procedure THERM is working on.  The stages of the calculation procedure are:

� Premeshing

� Reading Geometry

� Meshing

� Generating Input

� Simulating

� View Factors (optional)

� Simulating (optional)
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� Error Estimator (optional)

This section briefly describes each stage.  Also discussed are the possible errors which may occur at each
stage and suggestions on what to do if they occur.

7.3.1.  Premeshing

In this stage, the geometry is being prepared for meshing. THERM checks each polygon to make sure that
there are no problems that the mesher cannot handle. If there is a problem with a polygon, you will get a
message saying “Invalid Polygon found, Stopping Simulation,” followed by the polygon ID number. You can
find this polygon by going to the Edit/Special Select menu choice and typing in the polygon ID number in
the ID= field.  THERM will then select the problem polygon.

The most common cause for invalid polygons is zero area extensions, shown in Figure 7-8. THERM may
create zero area extensions in two ways.

(1) When very fine details are collapsed. This often happens with acute angles where one of the end points is
less than 0.01 mm away from a line. If this is the case, another point will be added to the line when the
boundary conditions are assigned and the two points will then be merged. The acute angle will be turned
into a zero area extension and with the two points lying on top of one another.

(2) When the Automatically adjust points within tolerance option is chosen during the generation of
boundary conditions. In this case, points within the checking tolerance (a distance of 0.1 mm) are merged
automatically by the program and the possibility of creating an invalid polygon is very high. This is why
it is recommended that you do not automatically adjust bad points without first inspecting them.

The selected
polygon has a zero
area extrusion.

Figure 7-8.  An example of a zero area extrusion which will result in an error message of "Invalid Polygon found, Stopping
Simulation".

In order to correct these kinds of invalid polygons you need to delete the tip of the extension, any additional
points that lie on it, and one of the two points that are lying on top of each other. Often it is easier to delete
the polygon and recreate it using the void fill feature.

During the meshing stage, THERM also checks to see if U-factor surface tags have been assigned. The
program was developed in large part for users interested in calculating U-factors so you will be warned if
you have not selected any U-factor surface tags. (See Section 6.2.4, "Define U-factor Surface Tags" for more
information). If none were selected intentionally, click on the OK button and the calculation will continue.
This question is not asked if the models are simulated using the Calc/Calculation Manager menu option.
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7.3.2.  Reading Geometry

During this stage, the mesher is reading the input data and storing it in a database for the mesher to read.
This should be a relatively short step, although occasionally a model will cause the program to hang during
this step. If this step takes longer than five minutes you should close THERM using the Microsoft Windows™
Task Manager, restart the program and try to rerun the model. If you are running the program with the
calculation in the background, and you forgot to save the model before calculating, you will be able to save
the model before shutting down the program.

7.3.3.  Meshing

In this stage, the mesh is being generated.  This is the most time consuming portion of the simulation process.

Occasionally, when modeling building components with multiple cross sections such as greenhouse
windows, or single cross sections with very fine detail, the mesh generator will have a problem creating a
mesh.  In this case you will get a message saying “Mesh Generation Error”.

If you get this error message, try simplifying the geometry near the identified point (the x and y coordinates
are given in the error message) or try increasing the Quad Tree Mesh Parameter value in the
Options/THERM File Options menu choice. (See Section 7.2.3, "Calculation Options" for more information
on the Quad Tree Mesh Parameter.) The point indicated by this error will be circled in red for easy location.
If the point is on the inside of a polygon, you will know which polygon is causing the problem. If the point is
on an edge shared by one or more polygons, any one of these polygons could be causing the problem. If this
is the case, the problem was probably caused by too many points too close together, leading to an over
detailed mesh in these areas. The most common cause for this mistake is the over specification of curves (see
section 5.4.1, "Suggestions for Drawing Cross Sections" for more information on modeling curves). It is likely
that the problem with the geometry is near the circled area but the mesh generator could be failing at that
point due to excessive detail somewhere else in the polygon. The polygon needs to be examined as a whole.
Make all possible simplifications to the polygon that do not compromise the accuracy of the simulation.
Usually very small modifications are all that is required.

If upon looking at the polygon there are no details you can change without compromising the model, try
rerunning the model with the Quad Tree Mesh Parameter (in the Options/THERM File Options menu
choice) set to a high value. This process may have to be repeated several times before the mesh can be
generated. In rare cases, the mesher has problems meshing a model because of previous problems with
another model. An easy way to determine if this is happening is to try to simulate a simple square and see if
the mesher fails. If it fails, save your model, exit the program, restart the program and try rerunning the
model. This often provides the necessary clearing of registers so the program can create a mesh.

7.3.4.  Generating Input

This stage indicates that the mesher is creating the input file for the CONRAD module. This stage is fast and
rarely produces an error.

7.3.5.  Simulating

The finite element calculation takes place during this stage.  This stage is fast and rarely produces errors. If
your model does generate an error in this step please contact us.

7.3.6.  View Factors (optional)

This stage indicates that the detailed radiation algorithm, VIEWER, is running.
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7.3.7.  Simulating (optional)

This stage will reappear if you are running the detailed radiation model. You may get an error message
saying the problem is not converging. In this case, you can increase the convergence criterion found under the
Simulation tab of the Options/Preferences menu choice. This criterion is a measure of the change in
temperature between iterations. The maximum value for the convergence that will yield reasonable accuracy
is 0.01. Do not modify this value unless you have to.

7.3.8.  Preparing Input (optional)

You will see this stage if you are running a model that uses the detailed radiation model, such as a detailed
radiation frame cavity, an external radiation enclosure, or the Condensation Index Model.  This stage creates
an input file for the VIEWER program.

7.3.9.  Error Estimator (optional)

The error estimator is run during this stage. If the results from this analysis indicate that the mesh needs to be
refined, the mesh will also be adapted during this stage. Then the steps of simulating and calculating view
factors will be repeated until the solution meets the convergence criterion. The following warning message
may appear:  “The maximum number of meshing iterations reached before the error target was reached.” If
this happens, the last set of results will be displayed. If these results are not acceptable, you will have to
increase the Maximum Iterations value in the Options/THERM File Options menu choice.  You may also try
performing the initial simulation at a higher value of the Quad Tree Mesh Parameter.

7.4.  Viewing the results
When the program has finished the simulation (the calculation steps in the status bar or the hourglass have
disappeared), you can view the results.  There are several different types of results displays:

� U-Factors

� Finite-Element Mesh

� Isotherms

� Flux Vectors

� Color Infrared

� Color Flux Magnitude

� Report

Select the Calculation/Display Options menu choice to open the Results Display Options dialog box, shown
in the figure below, which controls how the results are displayed.
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Figure 7-9. The Results Display Options dialog box allows you to choose the results that are displayed.

The following choices are available in the Results Display Options dialog box:

Draw Results This box must be checked in order for the graphic results to be drawn.  Default:
checked.

Show The Show section has the following choices, only one of which can be active at a time.
The setting will determine what graphic results are drawn by the program when you
click the OK button, as long as the Draw Results option is checked. These choices are
discussed in detail later in Section 7.4.5, "Graphic Results."

� Finite Element Mesh

� Isotherms

� Flux Vectors
� Color Infrared:  Drawing these results may take several minutes. You can press the

Esc key if you want to cancel the drawing of these results.
� Pixel resolution:  this value controls how finely the color infrared is drawn. If

you choose one pixel, THERM draws the image one pixel at a time, which can
be slow but gives the smoothest image. If you choose a higher number, the
program draws in blocks of pixels; the number you have chosen determines
how many pixels make up the sides of the block. The image is drawn faster
than using the one-pixel setting but does not appear as smooth.

� Color Flux Magnitude:  Drawing these results may take several minutes. You can
press the Esc key if you want to cancel the drawing of these results.

Show Min/Max
temperatures Check this box in order to display the minimum and maximum temperatures in the

simulation. This is discussed in more detail in the Min/Max Temperature section.
Show Element Ids Check this box to see the numerical ID values that have been assigned to each mesh

element. This is primarily a research feature. Default: unchecked.
Show Node Ids Check this box to see the numerical ID values that have been assigned to each mesh

node. This is primarily a research feature. Default: unchecked.

Set Screen Font Click this button to access a Font dialog box where you can select a font for the THERM
graphic display from the list of fonts that are installed on your computer. This option
can be useful if, for example, the labels of the isotherms do not display well on your
monitor; changing the font may make them more readable.

7.4.1.  U-factors

The U-factor results for the cross section are accessed by selecting the Calculation/Show U-factors menu or
using the Ctrl-F9 keyboard short cut.
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Figure 7-10.  Select the Calculation/Show U-factors menu to see the U-Factor results.

The U-factors dialog box will appear, listing the results for the cross section.  You can choose whether the U-
factor is based on total surface, projected x dimension, or projected y dimension. The temperature difference,
delta T, and the length used in the U-factor calculations are also displayed in this box. If the Percent Error
Energy Norm value is N/A, this indicates that the simulation was run with the error estimator turned off. (See
Section 7.2.3, "Calculation Options" for more information on the error estimator). If the error estimator was
turned on for the simulation, the value of the Percent Error Energy Norm would appear in this box.  Values
between 5-10% are indications of a well converged solution.  (Note that "convergence" means that further
refinement of the mesh will not increase the accuracy of THERM’s solution, as discussed in Section 7.2.3, "Calculation
Options".) When more than two U-factors are defined in a model, the additional labels and results appear in a
pull-down list.

Figure 7-11.  The U-factor results dialog box
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Figure 7-12 illustrates the definition of Projected X and Projected Y.

Projected X

Projected Y

Figure 7-12.  Projected X and Projected Y

To export the U-factor results to a text file, press the Export button, and a Save dialog box opens, allowing
you to save the file using any file name and directory. A "txt" extension is automatically added to the file
name. It is then possible to open the exported results file with any text editor (such as Notepad) or to import
it into a spreadsheet.

Step 1: To export the U-factor results
to a text file, click on the Export
button. The Save As dialog box is
displayed.

Step 2: Type the
results file name
and press Save.

Step 3: The U-factor results are now in
a text file, which can be opened with
any text editor, such as Notepad.

Figure 7-13.  You can export the U-factor results to a text file using the Export button on the U-factors dialog box.
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7.4.2.  Min/Max Temperature

The maximum and minimum temperatures calculated for the cross section are displayed if the Show
Min/Max temperatures box is checked in the Calculation/Display Options dialog box. When this choice is
checked, the location of the temperatures is indicated by a blue "X" for the minimum and a red "X" for the
maximum; a small dialog box appears, listing the temperature values and their x,y coordinates.

Figure 7-14.  Check the Show Min/Max temperatures box in Results Display Options dialog box.

When Show Min/Max temperatures is checked in the Display
Options dialog box, the Min and Max Temperatures dialog box
appears.

The location of the temperatures is
indicated by a blue check for the
minimum and a red check for the
maximum.

Figure 7-15.  Display of minimum and maximum temperatures

7.4.3.  Temperature at Cursor

When the calculations have been completed, you can view the temperature at any cursor location using the
following technique:

� From the View menu, click the left mouse button on the Temperature at Cursor choice. When this option
is active, a check mark will appear to the left of the choice. Clicking this choice will toggle it between
active and inactive.
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� A small Temperature dialog box will appear in the drawing area, and it will display the temperature
value of the nearest mesh node point at any cursor location, with no interpolation. It may be helpful to
use this feature with the Finite Element mesh displayed. The temperature is updated every time the
cursor is moved. The value will be N/A for any cursor position outside the cross section.

Step 2: A small Temperature
dialog box will appear,
displaying the temperature at
the current cursor location.

Step 1: From the View menu, click
the left mouse button on the
Temperature at Cursor choice
(when this choice is active, a
checkmark will appear to the left of

Figure 7-16.  Display of the temperature at the cursor location

� If you want to know the temperature at a specific location in the cross section, you can add that point to
the appropriate polygon (see Section 5.6.6, "Adding a Point"), which will force the mesher to put a node
there. Then you can use the Temperature at Cursor feature to view the temperature at the point after you
have calculated the results.

7.4.4.  Average Temperature with Tape Measure

After the calculation has been completed, you can obtain the average temperature along the line between two
points in the cross section using the Tape Measure Average Temperature feature of THERM.

The temperature of the sides of the equivalent rectangularized cavity are required inputs for the NFRC and
CEN method for calculating effective conductivity in frame cavities.  Standard default values are provided for
these temperatures.  You can use the average temperature feature after the model is run to check the
applicability of these default temperatures to the specific cross section.

To turn on this feature, select the Options/Preferences menu and the Drawing Options tab; check the Tape
Measure Average Temperature box.
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If the Tape Measure
Average Temperature is
checked, the program will
report the temperature with
the Tape Measure toolbar
button.

Figure 7-17.  Turn on the Tape Measure Average Temperature feature from the Options/Preferences menu in order to display the
temperature at a specific point.

With this feature turned on, click on the Tape Measure toolbar button, click the left mouse button on the
starting point where you want to measure the average temperature, move the cursor to the ending point, click
the left mouse button again, and a dialog box will display the average temperature between the two points.
Note that the cross section results need to be calculated before the program can display these temperatures.
Based on this temperature, using the simplified frame cavity model, you can edit the Side 1 and Side 2
temperature values in the Properties for Selected Polygons dialog box and then recalculate the results of the
entire cross section.

Note: These temperatures are changed in each frame cavity separately. Access to the temperature input is
obtained by double-clicking on the frame cavity or by using the Libraries/Set Material menu choice or
pressing F4 after the polygon is selected.
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Step 2: Click the left
mouse button on the
starting point, move the
mouse to the ending
point, and click the left
mouse button again.

Step 3: The Tape
Measure dialog box
shows the average
temperature.

Step 1: Click on the
Tape Measure toolbar
button. The mouse
cursor will turn into a
tape measure.

Figure 7-18.  Use the Tape Measure to determine the average temperature across a particular surface.

7.4.5.  Graphic Results

The graphic results can be displayed by selecting the Calculation/Display Options menu, which accesses the
Results Display Options dialog box.  The Show section offers different display options, only one of which
can be active at a time. Color Infrared and Color Flux Magnitude results may take several minutes to draw.
For a quick preview of the Color Infrared results, you can increase the value of the pixel resolution
parameter.

Figure 7-19.  Graphic results display options
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7.4.6.  Finite-Element Mesh

THERM automatically generates a finite-element mesh at the beginning of its calculations. The cross section is
broken into many discrete elements that are used to perform the finite-element calculation. Clicking on the
Finite Element Mesh choice on the Results Display Options dialog box (you must also have the Draw
Results box checked) causes the program to show the mesh used for the calculation. This reveals the areas in
the cross section where the program has divided the building component being modeled into a very fine
mesh (determined by the cross-section geometry and modified based on the percent error energy norm
criterion; see Section 7.2.3, "Calculation Options" for a discussion of the calculation settings for mesh
parameter and error estimator.)

Figure 7-20.  Graphic results:  Finite-element mesh
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7.4.7.  Isotherms

When the heat-transfer analysis is complete, THERM can display the lines of isotherms through the cross
section. Isotherms are useful for seeing where there are extreme temperature gradients (isotherms very close
together) that may lead to thermal stress or structural problems. Isotherms are also useful for identifying hot
or cold areas in the cross section, in order to predict thermal degradation or condensation.

Figure 7-21.  Graphic results:  Isotherms
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7.4.8.  Flux Vectors

The flux vector results indicate the amount and direction of heat flow through the cross section. There is one
flux vector for each mesh element (see the previous discussion in Section 7.4.6, "Finite Element Mesh" graphic
results). The length of the vector corresponds to the amount of heat going through the element, which is a
function of both the size of the element and the magnitude of the heat flux. These results can only be used for
quantitative comparison with a uniform mesh. The direction of the arrow indicates the direction of heat flow.
This representation of the data is most useful for determining the direction of heat flux.

Figure 7-22.  Graphic results:  Flux vectors
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7.4.9.  Color Infrared

The color infrared results show temperature gradients in the cross section. Each temperature is represented
by a different color; the cooler colors (purples and blues) are low temperatures, and warmer colors (yellows
and reds) are higher temperatures.

Figure 7-23.  Graphic results:  color infrared
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7.4.10.  Color Flux Magnitude

The color flux magnitude results represent the heat flux vectors, with the magnitude of the flux represented
by color; the cooler colors (purples and blues) are low flux and warmer colors (yellows and reds) are higher
flux. This display does not indicate the direction of the flux that is shown in the flux vector results.

Figure 7-24.  Graphic results: Color flux magnitude
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7.4.11.  Report

THERM generates a report each time a calculation is performed. This report contains a summary of the U-
factor result as well as a description of the elements in the cross section. A sample report is shown below.

From the File menu, select the Report choice to display the report for the currently active THERM file, shown
below. Click on the Print button to print the report; click on the Close button to close the report.

Figure 7-25. You can display the THERM report by selecting the File menu and Report menu choice.

The THERM File Properties dialog box, shown in Figure 7-26, is accessed using the File menu, Properties
choice. You can input information that may be helpful in managing THERM files. In addition, some of the
information in the report comes from this location. The following information can be entered into this dialog
box:

Filename The name of the THERM file. This is feedback from the program and cannot be edited.

Directory The full path name where the file is saved. This is feedback from the program and
cannot be edited.

Creation Date The date the file was created. This is feedback from the program and cannot be edited.

Last Modified The date the file was last changed. This is feedback from the program and cannot be
edited.

Title In this field you can give the model a name which is more descriptive than the THERM
file name. For example, the serial number and product name could be included here.

Created by In this field you can keep track of who created the model
Company In this field you can indicate your company affiliation.

Client In this field you can indicate who the work was for.
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Cross Section Type The information in this field will be included in the file that is exported to WINDOW,
indicating what type of window cross section you are modeling. The choices in this pull-
down list are:
� Divider
� Head
� Jamb
� Meeting Rail
� Sill

Notes In this field you can include any other information about the model.

Figure 7-26.  The File menu, Properties choice allows you to input information about the THERM file for the report.
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Figure 7-27. An example of a printed THERM report

Therm Version 2.00.04
Date: Thu Apr 30 14:08:23 1998

Created by:
Created for:

Therm Filename: D:\Thermdev\manual.thm
Cross Section Type:
Underlay Name: C:Files.dxf

U-factors

Name                 Length  Basis        U-factor
                       in.               Btu/h-ft2-F
-------------------- ------- ------------ --------
Frame                  3.22  Projected Y   0.0126
Edge                   2.50  Projected Y   0.3784

Condensation Index
Edge Temp
Frame Temp

Solid Materials

Name                       Conductivity   Emissivity
                            Btu/h-ft-F
-------------------------  -------------  ----------
Polysulphide                    0.11         0.90
Butyl Rubber                    0.14         0.90
PVC/Vinyl (Rigid)               0.10         0.90
Wood (Pine, Spruce, Fir)        0.08         0.90
Vinyl (flexible)                0.07         0.90
Fiberglass (PE Resin)           0.17         0.90
Silicone                        0.21         0.90

Cavities

Name: Frame Cavity (NFRC Simplified)
Gas Fill: Air
Convection Model: NFRC
Radiation Model: Standard

Poly  Heat        Side 1        Side 2    Dimension      Nu    Keff
 ID   Flow     Temp   Emis   Temp   Emis  Horz.  Vert.    #
      Dir        F             F           in.    in.        Btu/h-ft-F
----- -----  -------- ---- -------- ---- ------ ------ ------ ------
 105  Horz    44.60   0.90  24.80   0.90   0.15  0.04   1.00  0.0179
  10  Horz    44.60   0.90  24.80   0.90   0.85  0.19   1.00  0.0342
   3  Horz    44.60   0.90  24.80   0.90   1.50  1.25   4.23  0.1263
   4  Horz    44.60   0.90  24.80   0.90   0.09  0.50   1.00  0.0186
  17  Horz    44.60   0.90  24.80   0.90   0.03  0.03   1.00  0.0155
  21  Horz    44.60   0.90  24.80   0.90   0.32  0.10   1.00  0.0241
  20  Horz    44.60   0.90  24.80   0.90   0.17  0.14   1.00  0.0218
 100  Horz    44.60   0.90  24.80   0.90   1.79  0.58   2.42  0.0893
  23  Horz    44.60   0.90  24.80   0.90   0.12  0.22   1.00  0.0203
  30  Horz    44.60   0.90  24.80   0.90   0.29  0.20   1.00  0.0264
  36  Horz    44.60   0.90  24.80   0.90   0.39  0.04   1.00  0.0174
  28  Horz    44.60   0.90  24.80   0.90   0.20  0.07   1.00  0.0206
  42  Horz    44.60   0.90  24.80   0.90   0.23  0.38   1.00  0.0257
  43  Horz    44.60   0.90  24.80   0.90   0.06  0.10   1.00  0.0171
  44  Horz    44.60   0.90  24.80   0.90   0.22  0.29   1.00  0.0249
  61  Horz    44.60   0.90  24.80   0.90   0.33  0.06   1.00  0.0204
  69  Horz    44.60   0.90  24.80   0.90   1.53  0.67   3.49  0.1043
  19  Horz    44.60   0.90  24.80   0.90   0.15  0.25   1.00  0.0215
  24  Horz    44.60   0.90  24.80   0.90   0.08  0.08   1.00  0.0176
  40  Horz    44.60   0.90  24.80   0.90   0.16  0.13   1.00  0.0213
  54  Horz    44.60   0.90  24.80   0.90   0.30  0.42   1.00  0.0287

Glazing Systems

Name                 COG U-factor Overall Thickness  Cavity Height
                     Btu/h-ft2-F        in.               in.
-------------------- ------------ -----------------  -------------
Dbl,low-e, Ar          0.30             0.75              39.37

Standard Boundary Conditions

Name                 Temperature  Film Coefficient
                          F         Btu/h-ft2-F
-------------------- ------------ -----------------
Exterior Surface        -0.00         5.112
Interior Wood/Vinyl     70.00         1.340
Dbl,low-e, Ar U-fact    70.00         1.353
Dbl,low-e, Ar U-fact     0.01         5.050

Calculation Specifications
--------------------------

Mesh Parameter: 7
Estimated Error: Not Calculated
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7.4.12.  Export to WINDOW
THERM has a feature that allows you to export a THERM file to a WINDOW 4.1 file using the File/Export menu,
which accesses a dialog box where you can specify the name of the new file (it is given a t2w, i.e., THERM to
WINDOW extension) and the file format, which defaults to WINDOW 4.1. You can also specify a CSV or tab-delimited
format by scrolling the Format pull-down list.

Figure 7-28.  Exporting a THERM file to a WINDOW file format

You can choose to automatically save to a WINDOW 4.1 file every time you save a THERM file; use
Options/Preferences and check the Automatic WINDOW 4 Export on Save box.


